
http://www.facebook.com/share.php?u=http://www.quepublishing.com/title/9780789750877
http://twitter.com/?status=RT: download a free sample chapter http://www.quepublishing.com/title/9780789750877
https://plusone.google.com/share?url=http://www.quepublishing.com/title/9780789750877
http://www.linkedin.com/shareArticle?mini=true&url=http://www.quepublishing.com/title/9780789750877
http://www.stumbleupon.com/submit?url=http://www.quepublishing.com/title/9780789750877/Free-Sample-Chapter


Visio® 2013

Alan Wright and Chris Roth

800 East 96th Street, 
Indianapolis, Indiana 46240

WrightBook 1.indb   iWrightBook 1.indb   i 7/1/13   11:48 AM7/1/13   11:48 AM



Visio® 2013 Absolute Beginner’s Guide
Copyright © 2014 by Pearson Education, Inc.

All rights reserved. No part of this book shall be reproduced, stored in 
a retrieval system, or transmitted by any means, electronic, mechanical, 
photocopying, recording, or otherwise, without written permission from 
the publisher. No patent liability is assumed with respect to the use of 
the information contained herein. Although every precaution has been 
taken in the preparation of this book, the publisher and author assume no 
responsibility for errors or omissions. Nor is any liability assumed for damages 
resulting from the use of the information contained herein.

ISBN-13: 978-0-7897-5087-7
ISBN-10: 0-7897-508  7-2

Library of Congress Control Number: 2013936235

Printed in the United States of America

First Printing: July 2013

Trademarks
All terms mentioned in this book that are known to be trademarks or service 
marks have been appropriately capitalized. Que Publishing cannot attest to 
the accuracy of this information. Use of a term in this book should not be 
regarded as affecting the validity of any trademark or service mark.

Warning and Disclaimer
Every effort has been made to make this book as complete and as accurate 
as possible, but no warranty or fitness is implied. The information provided 
is on an “as is” basis. The author and the publisher shall have neither liability 
nor responsibility to any person or entity with respect to any loss or damages 
arising from the information contained in this book or from the use of the 
programs accompanying it.

Bulk Sales
Que Publishing offers excellent discounts on this book when ordered in 
quantity for bulk purchases or special sales. For more information, please 
contact

U.S. Corporate and Government Sales
1-800-382-3419
corpsales@pearsontechgroup.com

For sales outside of the U.S., please contact

International Sales
international@pearson.com

Associate Publisher
Greg Wiegand

Executive Editor
Loretta Yates

Development Editor
Susan Hobbs

Managing Editor
Kristy Hart

Project Editor
Andy Beaster

Copy Editor
Barbara Hacha

Indexer
Tim Wight

Proofreader
Dan Knott

Technical Editor
John Marshall

Publishing Coordinator
Cindy Teeters

Interior Designer
Anne Jones

Cover Designer
Matt Coleman

Compositor
Nonie Ratliff

WrightBook 1.indb   iiWrightBook 1.indb   ii 7/1/13   11:48 AM7/1/13   11:48 AM



Contents at a Glance

 Introduction ................................................................................................ 1

Part I Visio 2013 Basics ...................................................................................... 7

1 Getting to Know Visio 2013 ...................................................................... 9
2 Finding Your Way Around the Interface ................................................21
3 Working with Basic Diagrams .................................................................41
4 Taking Control of your Diagrams ...........................................................61
5 Working with Shapes ...............................................................................81
6 Manage Shapes ......................................................................................101

Part II Customizing .......................................................................................... 121

7 Connecting Shapes ................................................................................123
8 Making Advanced Diagrams .................................................................143
9 Shapes: Customizing .............................................................................167
10 Shapes: More Than Meets the Eye ......................................................185
11 Printing Visio Diagrams .........................................................................203

Part III Advanced .............................................................................................. 225

12 Sharing Visio Diagrams ..........................................................................227
13  Unique Needs: Touchscreens, Custom Templates, and
 Complex Printing Concerns ..................................................................245
14 Using Data ..............................................................................................265
15 Working with External Data and Data Graphics .................................287
16 Additional Visio Resources ....................................................................303
17 Collaborating with Visio ........................................................................315
18 Tips for Flowcharts, Process, and Block Diagrams .............................337
19 Tips for Working with Other Diagram Types ......................................353
 Index ........................................................................................................371

WrightBook 1.indb   iiiWrightBook 1.indb   iii 7/1/13   11:48 AM7/1/13   11:48 AM



Table of Contents
INTRODUCTION

What This Book Covers............................................................................................. 2

How This Book Is Organized .................................................................................... 3

Conventions Used in This Book ............................................................................... 3
Working with Visio Tools and Menus ................................................................. 4
Using Screen Illustrations .................................................................................... 4
Web Addresses .................................................................................................... 4

Special Elements to Watch For ................................................................................ 5

Part I Visio 2013 Basics .....................................................................................................7

1 Getting to Know Visio 2013 ..................................................................................9

What Is Visio? ...........................................................................................................10

Create a Basic Flowchart ........................................................................................10

What Else Can I Make? ...........................................................................................13

Which Edition Should I Use? ..................................................................................16

What Is New in the 2013 Editions? .......................................................................17
Improved Touch Support ..................................................................................18
Streamlined Layout ............................................................................................18
The New VSDX File Format  .............................................................................20

2 Finding Your Way Around the Interface ...........................................................21

The Ribbon ...............................................................................................................22
Embrace the Tab ................................................................................................22
Contextual Tabs .................................................................................................23
Template Tabs ....................................................................................................24
Customizing the Ribbon ....................................................................................24
Where Did That Command Go? .......................................................................29

Important Features of the Visio Application ........................................................30
The Quick Access Toolbar.................................................................................30
Context Menus ...................................................................................................31
The Backstage ....................................................................................................31
The Status Bar .....................................................................................................33

WrightBook 1.indb   ivWrightBook 1.indb   iv 7/1/13   11:48 AM7/1/13   11:48 AM



TABLE OF CONTENTS v

A Look at the Drawing Window .............................................................................33
Task Panes ...........................................................................................................34
Rulers and Grids  ................................................................................................34

Manipulating Shapes ...............................................................................................34
1D Shape Handles..............................................................................................35
2D Shape Handles..............................................................................................36
Vertex Handles ...................................................................................................36
Eccentricity Handles ...........................................................................................37

Get Around Using Your Keyboard.........................................................................38

3 Working with Basic Diagrams ..............................................................................41

Making Diagrams  ...........................................................................................................42
What Is a Template? ..........................................................................................42
Working Without a Template ............................................................................46
Clone Your Drawing ...........................................................................................47
Find Online Templates and Samples ...............................................................49

Save Your Diagram ..................................................................................................49
Save As ................................................................................................................49
AutoSave .............................................................................................................51

Working with Drawing Windows ............................................................................53
Task Panes ...........................................................................................................53
Switching Between Windows ............................................................................55
Working with Full Screen Windows ..................................................................57

4 Taking Control of Your Diagrams .......................................................................61

Working with Pages ........................................................................................................62
Adding Pages .....................................................................................................62
Inserting Pages ...................................................................................................63
Using Background Pages ...................................................................................64
Rename Pages ....................................................................................................66
Reorganizing Pages ............................................................................................66
Customizing Pages .............................................................................................67
Scaling Your Page ..............................................................................................71

Working with Themes .............................................................................................72
The Theme Gallery .............................................................................................73
Changing Themes on-the-Fly............................................................................76
Working with Color ............................................................................................77

WrightBook 1.indb   vWrightBook 1.indb   v 7/1/13   11:48 AM7/1/13   11:48 AM



vi VISIO 2013 ABSOLUTE BEGINNER’S GUIDE

5 Working with Shapes ............................................................................................81

Find the Right Shape ..............................................................................................82
Selecting Available Shapes  ..............................................................................82
Frequently Used Shapes ....................................................................................83
Changing Shapes ...............................................................................................87
Saving Favorites .................................................................................................89

Understanding Stencils ...........................................................................................90
What Is a Master? ...............................................................................................90
Creating Personalized Stencils ..........................................................................91
Edit Stencil Sets ..................................................................................................93

Searching for Shapes ..............................................................................................96

6 Manage Shapes ................................................................................................... 101

Using Groups to Organize Shapes ......................................................................102
When to Use Groups .......................................................................................102
When It Is Better to Avoid Groups .................................................................107
Editing Groups .................................................................................................107

Arranging Shapes ..................................................................................................108
Using the Dynamic Grid ..................................................................................108
Straighten Up Shapes with Auto Align ..........................................................109
Using Position to Arrange the Diagram .........................................................111
Old-School Grid, Ruler, and Guides ..............................................................115
When Overlaps Occur .....................................................................................117
Using Layout to Organize Shapes ..................................................................118

Part II Customizing ........................................................................................................ 121

7 Connecting Shapes ............................................................................................. 123

What Are Connectors? ..........................................................................................124
How to Connect Shapes ..................................................................................124
Understanding Connectors .............................................................................129
Connecting Shapes Versus Points ..................................................................129

What Happens to Connections… ........................................................................132
…When I Drag a Shape? .................................................................................132
…When I Split a Connector? ..........................................................................132
…When I Delete a Shape? ..............................................................................133

Modifying Connectors ..........................................................................................134
Formatting .........................................................................................................135
Routing Styles  ..................................................................................................136

WrightBook 1.indb   viWrightBook 1.indb   vi 7/1/13   11:48 AM7/1/13   11:48 AM



TABLE OF CONTENTS vii

Using Line Jumps .............................................................................................136
Manual Override ...............................................................................................138

Working with Connector Points ...........................................................................140
Adding or Removing Connection Points .......................................................140

8 Making Advanced Diagrams ............................................................................. 143

Organizing Diagrams ............................................................................................144
Containers .........................................................................................................144
Lists ....................................................................................................................148
Callouts ..............................................................................................................151
ScreenTips .........................................................................................................155
Using Headers and Footers .............................................................................157

Working with Text .................................................................................................159
Creating Text Boxes .........................................................................................160
Using Text Fields ..............................................................................................160

Layers ......................................................................................................................163
Creating Layers .................................................................................................163
When to Add Layers ........................................................................................165

9 Shapes: Customizing .......................................................................................... 167

Duplicating Shapes ...............................................................................................168
Making Several Copies ....................................................................................168

Resizing Shapes .....................................................................................................170

Rotating Shapes .....................................................................................................171

How to Format a Shape ........................................................................................172
Modifying Common Format Attributes..........................................................173
Modifying Less Common Attributes ..............................................................174

Using Format with Groups ...................................................................................175

Changing Text .......................................................................................................176
Editing and Formatting Text ...........................................................................176
Modifying Text Blocks .....................................................................................179

10 Shapes: More Than Meets the Eye .................................................................. 185

Understanding Special SmartShape Features ....................................................186
What Is Shape Data? ........................................................................................186
Right-Click Menus ............................................................................................186
Control Handles ................................................................................................187
Hyperlinks ..........................................................................................................188
Smart Tags ........................................................................................................188

WrightBook 1.indb   viiWrightBook 1.indb   vii 7/1/13   11:48 AM7/1/13   11:48 AM



viii VISIO 2013 ABSOLUTE BEGINNER’S GUIDE

Import External Images .........................................................................................189
What You Can Do with Images.......................................................................190
Resizing Images  ...............................................................................................192
Working with Clip Art ......................................................................................193

Using Excel Charts .................................................................................................194

Importing Scalable Vector Graphics ....................................................................196

Importing AutoCAD Drawings .............................................................................197
Adding Content to AutoCAD Drawings ........................................................200

11 Printing Visio Diagrams ..................................................................................... 203

Just the Basics .......................................................................................................204
Print from the Backstage .................................................................................204
The Print Preview Pane ....................................................................................208
Test Your Print Job ...........................................................................................210

Controlling the Space Around the Print Job ......................................................211
Headers and Footers .......................................................................................211
Margins ..............................................................................................................213

Selecting What You Will Print ..............................................................................214
Printing Just a Portion of a Diagram ..............................................................215
Selecting Specific Pages in Visio ....................................................................216
Background Page Printing (or Not) ................................................................217
Selecting Shapes to Print ................................................................................219
Printing by Layer ...............................................................................................219
Gridlines ............................................................................................................221

Get High-Quality Print Jobs .................................................................................221
Color Printing ....................................................................................................223

Part III Advanced ........................................................................................................... 225

12 Sharing Visio Diagrams ...................................................................................... 227

Share Drawings Using Email ................................................................................228
Visio Viewer .......................................................................................................229
SkyDrive .............................................................................................................230
Social Networks ................................................................................................232

Creating a Web Page from Your Diagram..........................................................234

Saving to Other File Formats from Visio .............................................................235
Creating PDF and XPS Files ............................................................................236
XML Formatted Drawings................................................................................237
Older Visio Formats .........................................................................................237

WrightBook 1.indb   viiiWrightBook 1.indb   viii 7/1/13   11:48 AM7/1/13   11:48 AM



TABLE OF CONTENTS ix

Getting Visio Drawings into Other Applications ................................................238
Office Applications ...........................................................................................238
Other Applications ...........................................................................................240
Exporting Drawings to Image Formats ..........................................................240

13 Unique Needs: Touchscreens, Custom Templates, and 
Complex Printing Concerns ............................................................................ 245

Touchscreens .........................................................................................................246
Switching Between Touch Mode and Mouse Mode ....................................246
Working with Shapes .......................................................................................247
General Touch Controls ..................................................................................248
The Touch Keyboard .......................................................................................251

Creating Your Very Own Template .....................................................................252

A Look at Complex and Multipage Print Jobs ...................................................256
Printing Tiled Drawings....................................................................................256
Using Page Scale ..............................................................................................258
Using Avoid Page Breaks ................................................................................260
Printing Mixed Orientation Drawings .............................................................260
Combine Drawings into a Single Sheet .........................................................262

14 Using Data ............................................................................................................ 265

What Can I Do with Shape Data? ........................................................................266
Exploring ...........................................................................................................266
Types and Uses.................................................................................................268

Creating Shape Data Fields .................................................................................269
Add a Simple Data Field .................................................................................270
Adding Lists and Format .................................................................................274
Saving a Set of Shape Data Fields .................................................................276
Displaying Text in Shape Data Fields ............................................................278

Creating Reports ...................................................................................................279
Using the Report Definition Wizard ...............................................................279
Generating Reports ..........................................................................................283
Adding Totals and Subtotals ..........................................................................285

15 Working with External Data and Data Graphics ........................................... 287

Linking Shapes to External Data ..........................................................................288
Look at Your External Data First .....................................................................288
Using Link Data to Shapes ..............................................................................289

What Are Data Graphics? .....................................................................................296
How to Create a Data Graphic .......................................................................296
Customizing Data Graphics .............................................................................299

WrightBook 1.indb   ixWrightBook 1.indb   ix 7/1/13   11:48 AM7/1/13   11:48 AM



x VISIO 2013 ABSOLUTE BEGINNER’S GUIDE

16 Additional Visio Resources ................................................................................ 303

Visio Viewer  ...........................................................................................................304

Resources and Tools .............................................................................................304
Visio Help ..........................................................................................................305
The Official Visio Blog .....................................................................................306
Office.com .........................................................................................................307

Additional Reading ................................................................................................310

Websites Worth Checking Out ............................................................................311

17 Collaborating with Visio .................................................................................... 315

SharePoint  .............................................................................................................316
Saving and Editing in SharePoint ...................................................................317
Co-Authoring ....................................................................................................320

Markup and Review in Visio .................................................................................323
Adding Comments ...........................................................................................323
Using Ink ............................................................................................................326
Using Track Markup .........................................................................................329

Don’t Share Too Much ..........................................................................................331
What Is Removed .............................................................................................334
What Is Not Removed .....................................................................................335

18 Tips for Flowcharts, Process, and Block Diagrams ....................................... 337

Process and Flow Chart Diagrams .......................................................................338
Auto Resize and Flowchart Shapes ................................................................338
Decision Shapes ...............................................................................................339
Using Subprocesses .........................................................................................340
Swimlanes and Phases in Cross-Functional Flowcharts................................342
Validating Your Diagram .................................................................................345

Business Process Diagrams (BPMN 2.0) and SharePoint Workflows ...............346
BPMN Diagrams ...............................................................................................346
SharePoint Workflows  .....................................................................................347

Block Diagram Tips ...............................................................................................348
Blend Block Shapes..........................................................................................348
3D Perspective Block Diagrams ......................................................................349

WrightBook 1.indb   xWrightBook 1.indb   x 7/1/13   11:48 AM7/1/13   11:48 AM



TABLE OF CONTENTS xi

19 Tips for Working with Other Diagram Types ................................................ 353

Working with Network Diagrams .........................................................................354
Logical Diagrams ..............................................................................................354
Rack Diagrams ..................................................................................................355

Timeline Tips ..........................................................................................................357

Org Chart Tips .......................................................................................................359
Create Org Charts Manually ...........................................................................361
Using the Organization Chart Wizard ............................................................363

Office and Space Plans .........................................................................................365
Creating Plans Using Shapes ..........................................................................366
Space Shapes....................................................................................................367

Working with Dimension Lines .............................................................................368

 Index ...................................................................................................................... 371

WrightBook 1.indb   xiWrightBook 1.indb   xi 7/1/13   11:48 AM7/1/13   11:48 AM



About the Authors
Alan Wright has worked professionally in and around IT for nearly 10 years. He 
has provided enterprise-level support in the Detroit, Michigan, area and continues 
to provide software and hardware support for small business and residential users. 
He holds several certifications from CompTIA and Microsoft and enjoys working 
with technology and teaching others how they can make technology work for 
them. 

Alan has been the technical editor on other books from Que Publishing, including 
Using Windows 8 and Microsoft Project 2013 In Depth. When not working 
with computers, he enjoys working on projects in his cabinet shop. Alan lives 
in northern Michigan with his wife, Pam, and their two children, Joshua and 
Jonathan. 

Chris Roth has always enjoyed creating pictures of any kind and absolutely enjoys 
the combination of computer technology with graphics. He has been working 
with Visio since The Beginning in 1992, when he was part of the Visio 1.0 team at 
then-extant Visio Corporation. Since then, he’s continuously been busy helping 
customers incorporate diagrams, drawings, and visualizations into their daily busi-
ness and to develop custom graphical solutions based on Visio. 

A Microsoft Visio MVP since 2002, he has presented sessions at several Visio con-
ferences and has written more than 250 articles about Visio for his “Visio Guy” 
website (www.visguy.com), which he launched in 2006. 

Originally from Seattle, he currently lives with his wife and baby daughter in 
Munich, Germany. Away from family, laptop, and relaxing Bavarian beer gar-
dens, he plays trombone with the TT Orchestra and the wind ensemble Pullacher 
Blasmusik.

WrightBook 1.indb   xiiWrightBook 1.indb   xii 7/1/13   11:48 AM7/1/13   11:48 AM



Dedication
To my loving and very patient wife, Pam; you will never know how glad I am to have 
you by my side.

—Alan Wright

Acknowledgments
Over the years, I have worked with and learned from many quality people who 
make technology and software enjoyable for me. Tim Scott and Scott Gaines are 
a couple of managers I have enjoyed working with and who have supported me 
over the years. Seth Melton, Tammy Mays, Nick Abughannam, and Shawn Elliott 
are a few other underappreciated IT professionals I have had fun working with.

Chris Roth has been a great source of Visio tips and how-to information for many 
years and has earned his Visio MVP recognition many times over.

I especially want to thank Visio MVP John Marshall, who has been a very 
knowledgeable and supportive technical editor on this book. As someone who 
has seen Visio develop since the beginning, he has a wealth of knowledge that he 
enjoys sharing. 

I want to thank Loretta Yates, Andy Beaster, and everyone at Que Publishing who 
has helped to bring this book about. 

Finally, I would like to single out and thank and acknowledge the support of 
J. Peter Bruzzese, who has been a great friend and likely shares some of the 
blame for where I am today.

—Alan Wright

WrightBook 1.indb   xiiiWrightBook 1.indb   xiii 7/1/13   11:48 AM7/1/13   11:48 AM



We Want to Hear from You!
As the reader of this book, you are our most important critic and commentator. 
We value your opinion and want to know what we’re doing right, what we could 
do better, what areas you’d like to see us publish in, and any other words of 
wisdom you’re willing to pass our way.

We welcome your comments. You can email or write to let us know what you 
did or didn’t like about this book—as well as what we can do to make our books 
better.

Please note that we cannot help you with technical problems related to the topic 
of this book. 

When you write, please be sure to include this book’s title and author as well as 
your name and email address. We will carefully review your comments and share 
them with the author and editors who worked on the book.

Email: feedback@quepublishing.com

Mail: Que Publishing 
 ATTN: Reader Feedback
 800 East 96th Street
 Indianapolis, IN 46240 USA

Reader Services
Visit our website and register this book at quepublishing.com/register for 
convenient access to any updates, downloads, or errata that might be available 
for this book. 

WrightBook 1.indb   xivWrightBook 1.indb   xiv 7/1/13   11:48 AM7/1/13   11:48 AM



I N T R O D U C T I O N

INTRODUCTION

Nervous, excited, frustrated, giddy, exhausted—maybe one of those words 

captures how you feel right now as you look at this Absolute Beginner’s 

Guide. Learning how to use a new piece of software or getting up to speed 

on a new version is not always fun. On the other hand, you likely enjoy 

learning new things when you see new possibilities and feel the benefits. 

Visio may be a mystery to you now, and you may feel some trepidation, but 

rest assured this book was designed to quickly get you comfortable with 

this amazing program. 

Visio is all about visualizing ideas and information. You can create amazing 

diagrams to show how processes work and how things interact. You 

can create floor plans and layouts with relative ease. Visio is used more 

often than you probably realize, from web content and org charts to 

advertising and business presentations. It has been said that a picture is 

worth a thousand words, and Visio allows you to speak volumes, which is 

why it has become an integral tool for businesses that put a premium on 

communication.
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2 VISIO 2013 ABSOLUTE BEGINNER’S GUIDE

Visio has been around since 1992 and has gone through some big transformations 
to keep pace with the demands of technology. If you have used it in the past, 
you’ll find some new features worth getting excited about. If you have never used 
it, prepare to be amazed. You will love how easy it is to create diagrams using 
templates and to preview changes using themes. Using Shape Data, you will find 
new ways to display information that are limited only by your imagination.

Despite the complexity and overwhelming potential that Visio presents, it is all 
built on basic concepts and tools that you will quickly grasp. If you have an artistic 
side, you will enjoy how satisfying Visio makes it to visualize and present informa-
tion and data.

The Visio 2013 Absolute Beginner’s Guide will assist you as you explore this appli-
cation and consider ways to change and improve your ability to communicate 
ideas and concepts to others. We’ll encourage you to poke around, try different 
things, and we will alert you to some best practices and tips. Above all, enjoy 
learning about Visio. 

What This Book Covers
Visio is a communication tool used everywhere by people of all backgrounds and 
all types of organizations. Because of this, we have tried to keep to the basics and 
provide essential tips and suggestions to help you save time and give you the 
knowledge needed to make you a power user, no matter how you use Visio. 

Although you may feel like an absolute beginner, we will quickly have you creating 
diagrams and working with Visio’s tools, and you will feel your confidence grow. 
You can follow along using different templates, and where more advanced 
concepts are considered, you will see the steps you can follow. At times we may 
only point out that there are more complex options or that more can be learned 
than we have space to develop.

Because Visio 2013 comes in three versions, we principally consider information 
that is practical to any user of Visio. We will try to point out anything that may be 
unique to specific versions along the way. A few chapters have content aimed at 
users with Professional or Pro for Office 365 versions, and we warn you when this 
is the case. 

With this book you will be able to do the following:

 • Create your own flowcharts, org charts, and network diagrams using a variety 
of shapes and connectors.

 • Create and manage customized shapes and arrange your own stencils.
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INTRODUCTION 3

 • Organize and arrange your diagrams using a variety of tools, such as 
containers, callouts, and layers.

 • Utilize SmartShape features and shape data to create more powerful 
communication tools.

 • Print your diagrams efficiently using an array of settings and tools to control 
what prints and how it will appear.

 • Export Visio content for use in other applications in different formats.

 • Share your Visio drawings with others through a variety of tools, including 
email, SkyDrive, and SharePoint. 

How This Book Is Organized
This book is arranged in three parts, which are broken down into chapters:

Part I, “Visio 2013 Basics,” helps you get familiar with the tabbed interface used 
in Visio 2013. You will become familiar with the components of a basic diagram, 
including Page Backgrounds and Themes. You will create drawings using 
Templates and understand the ins and outs of Shapes and Stencils.

Part II, “Customizing,” will deepen your awareness of additional features to 
be found in Shapes and Connectors. You will get to know tools that help you 
work better with content in your drawings using Containers, Layers, and Text. 
Editing, Duplicating and Formatting options are considered and you will dive into 
SmartShapes and Shape Data. You will learn all about Printing in this section.

Part III, “Advanced,” introduces you to the many ways you can share and export 
your diagrams into other formats. You will see how to use special Touchscreen 
menus and learn about other unique situations here. How to collaborate with 
other Visio users and where to find more Visio content and information will be 
considered. You will learn about more complex ways to use and work with Data, 
including data that is maintained outside of Visio. Finally, you will look at unique 
features and get some tips for working with specific templates and diagram types.

Conventions Used in This Book
Most terms specific to Visio will be explained as we go along in the book. 
However, there are a few terms and standards that we had in mind while 
preparing this book that we should explain at the outset. 
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4 VISIO 2013 ABSOLUTE BEGINNER’S GUIDE

Working with Visio Tools and Menus
When the book describes labels or titles that you can see on the screen while 
working with Visio, they will be capitalized. Instructions to press a specific key or 
keyboard combination will also be capitalized, like this:

 1. Select the Design tab.

 2. In the Page Setup section, click the Page Setup button or press Shift+F5. 

 3. Review settings on the Page Size tab and click OK. 

Because of touchscreen interfaces, we generally use the term “select” rather than 
“click” to describe the process of activating a button or menu item, so feel free to 
click, tap, or press the indicated item to carry out the action. When there is a need 
to activate a button to continue to another step, “click” tends to sound better and 
has been used for that reason.

Using Screen Illustrations
The screen illustrations used throughout the book as figures are a valuable 
reference tool. Generally, illustrations will show you the step being discussed in 
the text. Some illustrations are cropped to focus attention on details, whereas 
others show the whole Visio window to help you get familiar with how things are 
laid out. Look around and notice tabs and features that are not being discussed, 
just to get a feel for where things are located. Occasionally, we may include 
callouts or combine multiple elements in a single illustration so that you can 
compare menus or layouts.

Web Addresses
You may see web addresses referred to in the book. These are offered as points 
of reference in examples, or they may point to additional information or resources. 
They will appear in this format:

http://www.microsoft.com

Throughout this book you will see the words “drawing” and “diagram” used 
almost as synonyms. Both are words used in the Visio interface, and they tend 
to be interchangeable. Technically, a diagram refers to a more conceptual 
drawing, whereas a drawing conveys the idea of a more finished product with 
measurements and details. In practice, some types of templates tend to be 
considered as diagrams, whereas others are more often referred to as drawings. 
Don’t think you need to read into the way these terms are used in this book.  
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INTRODUCTION 5

Special Elements to Watch For
As with all books in this series, Visio 2013 Absolute Beginner’s Guide includes 
special items that provide additional information that will add to your 
understanding:

TIP Tips indicate a useful time-saving step, shortcut, or a way 
for you to easily get better results.

NOTE Notes provide additional background information or 
related material about the task or topic being considered. It’s not 
information you absolutely need to know, but it may provide you 
with a clearer understanding of the topic.

CAUTION Cautions alert you to potential undesirable results 
and point out items or choices that could cause problems if mis-
understood or accidently used.

Although you could read this book from beginning to end, you will likely find it 
practical to jump around, and we have included references to subjects that are 
considered more in depth in other places in the book. Feel free to go back and 
forth as you get familiar with specific tasks and topics.
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I N  T H I S  C H A P T E R

3
• How will templates save me time?

• What make templates different?

• How can Visio save my diagram?

• How will using multiple windows help me develop 
mad multitasking skills? 

WORKING WITH BASIC 
DIAGRAMS
Visio is all about making great visuals, and you will spend a lot of time 

focused on the drawings themselves. This chapter provides a good point 

to step back and see all the other features of Visio that will help you later 

as you work on those drawings. Consider how choosing the right canvas 

and frame can make a great work of art look awesome.

Templates, file formats, pages, backgrounds, and your work area are all 

fundamental to having the right canvas and frame for the drawings you 

create. We look at templates and the drawing window in detail in this 

chapter. Chapter 4, “Taking Control of Your Diagrams,” considers how 

pages and backgrounds further accentuate your work.
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Making Diagrams 
I enjoy building cabinets from scratch. Despite how satisfying the final product can 
be, finding the right wood and materials can be time consuming, and the project 
can also take much longer than expected (sorry, dear). For that reason I have on 
occasion been quite happy with purchasing a cabinet from IKEA and spending a 
fraction of the time assembling a very nice-looking cabinet. 

Templates serve a similar purpose. No one questions your imagination and artistic 
abilities, and you certainly can create drawings from scratch in Visio if that is your 
preference. You will quickly appreciate the many advantages of using templates 
when you see how they save you time. 

What Is a Template?
We’ve thrown this   term around quite bit, but what is a template? Templates refer 
to the overall framework that determines appearance, purpose, and even the tools 
that are used to make your diagram. They include the sets of shapes and stencils 
present in the Shape panel; the size and scale of the page you work on; the paper 
size for printing; settings related to font, color, and many others that dictate the 
default behavior of shapes and connectors in your diagram. You might even see 
additional Ribbon tools unique to that template, as in the case of an Organization 
Chart template.

Find the Right Template
We used a Basic Flowchart template in Chapter 1, “Getting to Know Visio 2013,” 
and you no doubt were tempted to check out some of the other templates in the 
Template Gallery    (see Figure 3.1). Visio 2013 Standard includes many predefined 
templates, and Professional has even more. The included templates have a very 
modern look with shapes and content that have been selected to reflect the times 
we live in.

When you choose to start a new Visio diagram, you are presented with featured 
templates by default.     You can refine the choices by using categories, which 
presents eight groups of templates as shown in Figure 3.2 (Business, Engineering, 
Flowchart, General, Maps and Floor Plans, Network, Schedule, and Software and 
Database). 

In addition you can search for online templates. We’ll come back to this feature 
later in this chapter.
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FIGURE 3.1

Right away, you may recognize a few interesting-looking choices in the Template Gallery.

FIGURE 3.2

There are eight categories of templates.
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Take a look at the purpose of these categories and what sets them apart from 
each other.

 • Business templates    include Organization Charts, Marketing, and Charts and 
Graphs. You find tools for analyzing processes such as Cause and Effect or 
Fault Tree. Many people have learned to use mind mapping or brainstorming 
diagrams. 

 • Engineering offers    several templates, including Basic Electrical and Part and 
Assembly Drawing (see Figure 3.3).     

FIGURE 3.3

Looking at a category of templates provides an array of choices, as these engineering 
templates illustrate. 

 • Flowchart templates include the Basic Flowchart, BPMN Diagram, and 
Workflow Diagrams.    

 • General includes Basic Diagram and Block Diagrams. This is a good area to 
start with if the diagram only needs very basic shapes and stencils.    

 • Maps and Floor Plans    include many types of templates. You can create 2D 
or 3D map graphics for advertising, floor plans and layouts, detailed HVAC, 
ceiling grids, and site plans. 

 • Network templates    include ways to represent the physical network, rack 
diagrams, and more conceptual diagrams to visualize Active Directory or LDAP 
Directories.
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 • Schedule templates    provide tools for calendars, Gantt charts, and timelines.

 • Software and Database    has many templates, such as Data Flow, Database 
Notation, Program Structure, and Web Site Map.     

When you select a specific template  , a small    window appears (see Figure 3.4) 
with a few details related to the purpose of the template and its origin. You can 
choose to use Metric or U.S. units of measurement and then select Create. You 
can also scroll to the left or right, clicking arrows to browse other templates.

FIGURE 3.4

Selecting a template provides you with an explanation of how you would use this template. 

HOW TO VIEW TEMPLATES
Think of a template as an     advanced starting point for your diagram. At times it is 
enough to have a flowchart template and a blank page. However, if you find that 
you often are creating similar content or variations on the same diagram, you might 
consider setting up and saving your own template. 

In a personalized template you can determine the shapes and stencils available. You 
can also include personalized elements, such as company logos. To further customize 
the starting point of your diagrams, you can even include a page with prepopulated 
content. 
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➜  To learn how to create your own templates in Visio, see page 252.

Working Without a Template
You can start with a blank drawing    if you decide not to use the templates for the 
sake of a quick diagram. You simply choose Blank Drawing from the selection of 
templates featured when you first open Visio. 

If you have been working in Visio and want to create a new drawing, follow these 
steps:

 1. Select the File tab to open the Backstage area. 

 2. Select New from the vertical menu to the left. You see the list of featured 
templates to the right.

 3. Select Blank Drawing and Create on the pop-up window that appears. Blank 
drawings open with no shapes, stencils, or any other configuration settings 
(see Figure 3.5). You can still work right away, selecting shapes and such from 
the Home tab and the Tools menu.

FIGURE 3.5

Starting a drawing from scratch using a blank drawing.
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Clone Your Drawing
When you have invested blood,      sweat, and tears into a diagram, you might not 
want someone else to tamper with it. Imagine that you need to make an updated 
version of an organization chart after a promotion has occurred in your company. 
Maybe you want to present a couple of similar variations of a diagram in a 
proposal with your customer. Rather than grabbing the original and modifying it, 
it might be wiser to clone the original and modify the copy. That way, you always 
have an intact original to refer back to.

Use a Recent Drawing
If you need to tweak a diagram or present variations of the same diagram, a nice 
feature is the capability to easily create a copy of an existing drawing from the 
Recent Drawings list in Visio. 

 1. Open Visio and look for the list labeled Recent off to the left.

 2. Right-click a file and select Open a copy as shown in Figure 3.6. (The link at 
the bottom of Recent files labeled Open Other Drawings will take you to the 
Recent Drawing list discussed in the next set of steps.)

 3. Notice a copy has opened with a name like Drawing1. Any alterations to this 
drawing will have no effect on the original; they are completely separate.

 4. To save this copy, Select File and Save As to assign a unique name and 
location. 

If the drawing is not listed in the Recent Drawing list, open it first so you have the 
option to right-click as described.

There is another way to get to this list of recent drawings:

 1. Select the File tab and then select Open.

 2. As shown in Figure 3.7, helpful thumbnails display when you view the list in 
this way. 

 3. Right-click a drawing and select Open a copy.

If you anticipate using a drawing as a base for future copies or just want to keep it 
handy, you can also pin the drawing to the Recent Drawing list. As you hover your 
mouse over the document in the Recent list, you see a pushpin to the right. As 
shown in Figure 3.6, when you click the pin you see the document pinned to the 
top of this list until you unpin it.       
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FIGURE 3.6

Use Open a Copy to protect your original diagram from accidents.

FIGURE 3.7

The Recent Drawings list can also display thumbnails of your diagrams.

WrightBook 1.indb   48WrightBook 1.indb   48 7/1/13   11:48 AM7/1/13   11:48 AM



CHAPTER 3  WORKING WITH BASIC DIAGRAMS 49

Find Online Templates and Samples
As mentioned earlier,  when you look at the Template Gallery you see at the 
top of the page a field that allows you to search for templates from office.com. 
In addition, you can search other websites and then download templates and 
samples to use as a starting point for your own diagrams. Try to download from 
trusted sources to avoid unexpected surprises. 

➜  To find recommendations for online templates and samples, see page 311.

Save Your Diagram
Save your work. It’s easy to say, but it’s not something we always remember to 
do. The mere thought might bring back memories of frustration and the Luke 
Skywalkian cry of “Nooo!” that escaped your lips when an application froze or 
power was lost once long ago. Visio provides a few ways to save you from those 
feelings of remorse. 

Save As
Save As is an important    place to start soon after you create a new drawing. 
When you select the Save icon in the Quick Access toolbar for the first time, 
it automatically takes you to the Save As screen (see Figure 3.8). You can also 
click the File tab and choose Save As on the left, or you can use Ctrl+S on the 
keyboard. 

FIGURE 3.8

You have a few places to choose from when saving your work.
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A new feature in Visio 2013 is the inclusion of SkyDrive as a location to save your 
work. This cloud-based location  is associated with your Live ID. When saved to this 
SkyDrive, you can access the content from any computer with Internet access, and 
you can even share files from your SkyDrive. 

➜  To learn more about sharing your drawings using SkyDrive, see page 230. 

THE NEW VISIO FORMAT .VSDX
Visio 2003, 2007, and 2010 all used a common .vsd format. So why change things 
now?   Don’t worry; this is not a ploy to force people to upgrade. Every new release of 
Visio has used a proprietary .vsd format that has evolved from version to version. So it 
should not surprise us that Visio 2013 has a new format. So what are the advantages 
of this new format?.

The new .vsdx format uses XML content and essentially saves your file in a zipped 
compression that results in much smaller file sizes. This is also consistent with other 
Office applications that now use XML for their default formats, thus Word has .docx 
and Excel uses .xlsx. This is great when sharing files, and it also conserves storage 
space. Another perk is that XML is considered safer and more resistant to data 
corruption and viruses.

With this new file format, new features can be used when working in a SharePoint 
environment, such as coauthoring a diagram. For developers, .vsdx provides new 
ways to work with Visio drawings, for example, programs can be designed to read 
and extract data from drawings, and content in drawings can be updated to reflect a 
new logo without opening the files.   

When you use Save As, you can choose the file format that you want to use. As 
you can see in Figure 3.9, there are many formats to choose from. The default 
is named Visio Drawing; it is a new format and uses the .vsdx file extension. The 
Visio 2003–2010 Drawing format choice may be practical when sharing drawings 
with others who use older versions of Visio.

➜  To learn more about other formats, see page 235.
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FIGURE 3.9

From Visio, you have many choices when choosing how to save your diagrams.

AutoSave
    AutoSave does what the name implies; it automatically saves your work—if it is 
configured, that is. Whereas your concern about saving a test diagram may not be 
the same as saving an organization chart you have worked on for the past three 
days, it is a good idea to know AutoSave is enabled and which settings are being 
used (see Figure 3.10). 

 1. Click the Home tab to access the Backstage area.

 2. Click Options at the bottom of the vertical menu on the left.

 3. Select Save under Visio Options and verify your settings.

 4. Click OK to save changes.
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FIGURE 3.10

You have several options when using AutoSave.

In Figure 3.10, you see the setting options for Save. Here you can change 
the default format using the Save Files in This Format drop-down menu. Save 
AutoRecover Information Every X Minutes allows you to enable and change the 
default of 10 minutes to a shorter period of time. It is not enabled by default. To 
minimize the amount of work that can be lost due to a power outage or because 
a computer suddenly stopped working, some people change this to 5 minutes or 
even less. If the file itself is extremely large or complex you might notice a slight 
hit on performance. If that happens then increase the interval. You may prefer to 
enable or disable other settings here if you desire to further fine-tune your save 
experience. 

TIP If you find that the AutoSave settings do not work consis-
tently, they may have been applied only to whichever drawing 
was open at the time you made adjustments. Close all drawings 
and follow the previous steps to open the Save options. Confirm 
the settings you want enabled and then click OK. Now when you 
open new or old drawings they should have these Save settings.     
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Working with Drawing Windows
As you become more proficient with Visio, you might want more than one drawing 
open at a time. Visio allows you to easily navigate among open drawings. The way 
Visio handles multiple open drawings deserves a quick overview. 

The Visio application is itself a window and can be moved, resized, and minimized, 
like any Microsoft application. This application window includes the tabbed ribbon 
interface. The main Visio application window can contain any open Visio files, 
the same as modern web browsers allow for multiple tabbed web pages in one 
window. You might notice what appear to be several stacked windows on the 
Windows task bar; they are likely all contained in one Visio application window. 
For this reason the ribbon and tabs across the top do not appear to alter when 
changing from one diagram or drawing window to another.

NOTE You may occasionally    have a diagram that has a unique 
tab that is needed only by that diagram, as in the case of an 
office layout that uses a Plan tab. If you switch between a flow-
chart diagram and an office layout diagram, the Plan tab appears 
or disappears, depending on the drawing window that is active.

Drawing windows   refer to the work area below the ribbon interface where 
you create your diagrams and drawings. Drawing windows can be minimized, 
maximized, and arranged below the tabbed ribbon bar. 

CAUTION If you decide to close a drawing window, make 
sure    you choose the correct X to do this. When your drawing 
window is maximized, you see the standard application window 
controls in the upper-right corner of the Visio window for Help, 
Minimize, Maximize, and Close. Below that you see a second X, 
which is the one to use to close the drawing window.

Task Panes
Besides the Drawing window,  you have likely noticed task panes by now. These 
may reveal more detailed information or provide additional options to work with 
your diagram. There are four common task panes in Visio:

 • Shapes

 • Shape Data

 • Pan and Zoom

 • Size and Position
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In the Show section     of the View tab you can enable or disable task panes by 
clicking the Task Panes drop-down button and selecting to toggle it on or off. 
In Figure 3.11 you can see four task panes listed. Shapes and Pan & Zoom are 
toggled on and can be seen below in the drawing window. 

FIGURE 3.11

Task panes can be turned on or off from the View tab.

The Shapes task pane   we used previously and by default is turned on anytime 
we open a new drawing window. It is docked on the left side of the window by 
default. 

TIP You can undock    the Shape pane and let it float elsewhere. 
Hover your pointer over the word Shapes in the header area of 
the pane. When you see the cursor change, click and drag the 
pane to a different location. Alternatively, you can minimize its 
size by clicking the small arrow to the left    of the word Shapes, as 
shown in Figure 3.12. The pane shrinks to the left and reveals a 
single column of shapes. Click the arrow again to expand.

You may see other task panes occasionally, and some are unique to certain 
templates. They all can be moved, docked to the edge of a drawing window, 
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resized, and anchored to the edges of a drawing window.    Anchoring the pane 
allows you to automatically hide (Auto Hide) them so they fly open only when you 
hover over them. 

Switching Between Windows
If you open the View tab, you notice     a section labeled Window. This refers to the 
drawing windows you may have open. You see four buttons here:

 • New Window

 • Arrange All

 • Cascade

 • Switch Windows

To quickly jump between windows, you may be able to use Ctrl+Tab on the 
keyboard. Another option is to click Arrange All to split the available screen 
space among the open drawings.    This provides a way to see a portion of all open 
drawings, as shown in Figure 3.12. You might use this to compare drawings side 
by side.

FIGURE 3.12

You can see all open drawing windows at once using Arrange All.
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You can also select the Cascade button to see the open windows arrayed by their 
Title bar (see Figure 3.13). This can  be useful when you have many open draw-
ings and you need to quickly find a specific one. When you select the drawing you 
want, you can maximize the drawing window by double clicking the Title bar or by 
using the traditional Windows maximize button located in the upper-right corner 
of the window. This also removes the cascade effect.

FIGURE 3.13

You can use Cascade view to get a handle on what is open.

Use the New Window button to open a second     view of the current drawing. You 
are not making a copy; you have an additional drawing window to the same 
drawing. Changes made in the first window are seen in the second, and vice 
versa. This can be useful when working with a large diagram; one window can 
focus on one area, and the second can position over another area. Now you can 
jump between drawing windows rather than move back and forth on the diagram. 
Notice how this is used in Figure 3.14; both Kitchen Remodel:1 and Kitchen 
Remodel:2 are different views of the same drawing arranged side by side.
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FIGURE 3.14

The New Window feature enables you to see the same drawing from different perspectives. 

Working with Full Screen Windows
Full screen or Presentation      mode enables you to look at your Visio drawings like 
a PowerPoint slideshow (see Figure 3.15). To enter Presentation mode, click the 
projector screen on the bottom status bar just to the left of the zoom slider, or 
press F5. To escape, hit F5 again, Esc, or right-click and Close.

You are not able to modify the drawing while in full screen, but you can evaluate 
how the finished product will look. You can navigate through multiple pages by 
right-clicking and using the Go To menu or by using your arrow keys.
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FIGURE 3.15

Full screen provides an unobstructed view of your drawing page.

THE ABSOLUTE MINIMUM
You have seen the value of templates when you start a diagram. It is a good 
idea to poke around a bit the first time you use a template. Make sure you are 
comfortable with the way elements in this template connect to one another. Read 
the description for the template to see if it really fits the style of diagram you need 
to create.

Protect your work by using copies of diagrams when appropriate and save your 
work often. If you haven’t used the AutoSave feature, take the time to enable and 
configure it to minimize lost work.
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It is important to understand how and when to use the Arrange All and New 
Window features to help you be as efficient as possible. Visio is designed to help 
you easily navigate between drawings and avoid frustration. Experiment with some 
of these display features now and you will feel more confident as you quickly 
create impressive diagrams that amaze your co-workers.

WrightBook 1.indb   59WrightBook 1.indb   59 7/1/13   11:48 AM7/1/13   11:48 AM



WrightBook 1.indb   60WrightBook 1.indb   60 7/1/13   11:48 AM7/1/13   11:48 AM



Numerics
1D shapes

handles, 35
resizing, 170

2D shapes, handles, 36

A
action tags. See smart tags
adding

callouts to shapes, 151-154
commands to ribbon, 25-27
comments, 323-327
connection points, 140-142
content to CAD drawings, 200
Data Graphics, 296-298
fields to headers and footers, 211
groups to stencils, 106
layers, 165
pages to drawings, 62
photos to org charts, 359-361
shape data fields, 270-274
shapes to Favorites stencil, 89

adjusting
print margins, 213
resolution of images, 192

Adjust tool group (Picture Tools), 190
aligning

shapes on Dynamic Grid, 109
text, 179

Align tool, 110-111
anchoring task panes, 55
angles, nonorthogonal, 139
applications, Office, compatibility with, 238-240
applying themes to pages, 76
arcs, eccentricity handles, 37
Arrange All command, viewing open drawing 

windows, 55

arranging
diagrams with Position tool, 111-112
shapes with Dynamic Grid tool, 108-109

aspect ratio, overriding, 170
attributes

common format attributes, modifying, 173
less common format attributes, modifying, 

174-175
Auto Align & Space tool, 

110-112
Auto Resize feature, 338
Auto Size tool, 69-71
Auto Space tool, 112
AutoCAD (Automated Computer-Aided Drafting) 

drawings
adding content to, 200
importing, 197-199

AutoConnector feature, 124-127
Automatically Link tool, linking external data to 

shapes, 293-294
AutoSave, 51-52
available stencils, browsing, 87
Avoid Page Breaks tools, 260

B
background pages

creating, 64
printing, 217-219
title

modifying, 66
background printing, 208
Backstage, 22, 31-33

printing from, 204
background printing, 208
collation, 206
paper orientation, changing, 206-208
Print Settings pane, 204-205

Index
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372 BALLPOINT PEN TOOL (INK)

Ballpoint Pen tool (Ink), 327
behavior of connectors

during drag operations, 132
when shapes are deleted, 133-134
when splitting connectors, 132-133

blank pages, adding to drawings, 62
blending shapes, 348
block diagrams, blending shapes, 348
Block Diagram with Perspective template, 

349-350
blogs

blogs.msdn.com/b/chhopkin, 313
the official Visio blog, 307

BPNM (Business Process Model and Notation) 
flowcharts, 346

browsing available stencils, 87
building plans, dimension lines, 368-369
Business templates, 44
buttons, 23

Position button
Distribute tools, 113
Orient Shapes tools, 114-115

Presentation Mode button, 33
bvisual.net, 312

C
CAD drawings

adding content to, 200
importing, 197-199

calculations, performing on shape data field 
values, 298

callouts, adding to shapes, 151-154
Cascade button, viewing open drawing 

windows, 56
categories 

of templates, 42-45
of themes, 72

Change Shape tool, 87-89
changing

background of text blocks, 181-183
orientation of pages, 67
paper orientation for printing, 206-208
scale of drawings, 71

shapes with Change Shape tool, 87-89
themes, color, 74
z-order of shapes, 118

charts
organization charts, 359

creating, 363-365
creating manually, 361

photos, adding, 359-361
clip art, 193
cloning drawings, 47
Close Ink Shape tool (Ink), 327
closing

drawing windows, 53
ink shapes, 328

co-authoring tools
SharePoint, 316, 320-322
Visio drawings, checking out, 318-319

collaboration
comments

adding, 323-324
hiding, 324-326

SharePoint, 316
co-authoring, 320-322
versioning, 320

Visio drawings, checking out, 318-319
collated printing, 206
collapse ribbon, 23
color

applying to drawings, 77-78
of themes, changing, 74
print settings, changing, 223

Color and Weight tool (Ink), 327
combining drawings on a single sheet, 263
commands

adding to ribbon, 25-27
locating with Visio Options dialog box, 29

comments
adding, 323-327
hiding, 324-326
Track Markup tool, 329-331

common format attributes, modifying, 173
compatibility with Office applications, 238-240
compressing images, 192
Compress Picture tool, 192
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configuring print features
headers and footers, 211-213
margins, 213-214

connection points, adding, 140-142
Connection Point tool, 141
connections, creating with AutoConnector, 

124-127
connectors, 124-125

behavior
during drap operations, 132
when shapes are deleted, 133-134
when splitting connectors, 132-133

connection points, adding, 140-142
control handles, 138-139
creating 

with AutoConnector, 125-127
with Connector tool, 127

formatting, 135
glue

dynamic, 130-131
point-to-point, 129-130

line jumps, 136-138
properties, 129
routing styles, 136

Connector tool, 127
containers, 103, 144-147

lists, 148
modifying, 147-150

content, adding to CAD drawings, 200
context menus, 31
contextual ribbon

cross-functional flowcharts, 344-345
contextual tabs, 23

control handles, 187
1D shape handles, 35
2D shape handles, 36
of connectors, 138-139
eccentricity handles, 37
vertex handles, 36

controls available on tabs, 22
conventions used in this book, 17-18
copying

drawings, 47
shapes, 168

creating
background pages, 64
connections with AutoConnector, 124-127

connectors with Connector tool, 127
custom themes, 75
diagrams without templates, 46
floor plans, 366-367
flowcharts, 10-11
groups, 103-106
layers, 163-165
master shapes, 94
org charts, 361-365
personalized stencils, 91-93
reports, 279, 281-285
ScreenTips, 155
templates, 252, 255
web pages from diagrams, 234

cross-functional flowcharts, 150
contextual ribbon, 344-345
swimlanes, 343
resizing, 343

Current View, printing portions of diagrams 
with, 215-216

curved lines, eccentricity handles, 37
customizing

Data Graphics, 299-301
page orientation, 67
page settings, 63
ribbon, 24, 27
stencils, 91-93
templates, 45

custom templates, creating, 252, 255
custom themes, creating, 75

D
data fields

saving, 276-278
shapes, 266-274
text, displaying, 278

Data Graphics
adding, 296-298
customizing, 299-301
Position settings, changing, 300

data linked from external source, 
refreshing, 295

Data tab, linking external data to shapes, 
289-292

Decision shapes, 339
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374 DEFAULT PRINT OUTPUT VERSUS HIGH QUALITY OUTPUT

default print output versus High Quality 
output, 222

deleting shapes, behavior of connectors during, 
133-134

Design tab
Auto Size tool, 69-71
pages, customizing, 67
Theme Gallery, 73

Developing Microsoft Visio Solutions (Microsoft 
Press), 311

diagrams
arranging with Position tool, 111-112
block diagrams

shapes, blending, 348
Block Diagram with Perspective 

template, 350
callouts, 151-154
cloning, 47
connection points, adding, 140-142
connectors, 124-125

behavior during drag operations, 132
behavior when deleting shapes, 133-134
behavior when splitting connectors, 

132-133
control handles, 138-139
creating with AutoConnector, 125-127
creating with Connector tool, 127
dynamic glue, 130-131
formatting, 135
line jumps, 136-138
point-to-point glue, 129-130
properties, 129
routing styles, 136

containers, 144-147
creating without template, 46
footers, 157-159
gridlines, printing, 221
grouped shapes, when to avoid, 107
headers, 157-159
legends, inserting, 299
printing portions of, 215-216
saving

with AutoSave, 51-52
with Save As, 49

ScreenTips, 155
shapes

frequently used, 84-86
Quick Shapes stencil, 83
selecting, 82

templates, 42
Business templates, 44
categories of, 42-45
Engineering templates, 44
Flowchart templates, 44
General templates, 44
Maps and Floor Plans templates, 44
Network templates, 44
online templates, 49
personalized templates, 45
Schedule templates, 45
selecting, 45
Software and Database templates, 45
Template Gallery, 42

text boxes, 160
text fields, 160-162
validating, 346
web pages, creating, 234

dialog boxes
Field, 298
Layer Properties, 220
Page Setup, 63
Reorder Pages, 67
Ruler and Grid, 116
Visio Options

commands, locating, 29
ribbon, customizing, 25

dimension lines, 368-369
disabling task panes, 54
displaying

grid, 115-116
guides, 115-116
keyboard shortcuts, 39-40
page breaks in Print Preview pane, 208
printer properties, 205
ruler, 115-116
text in shape data fields, 278

distributing shapes, 113-114
drag operations, behavior of connectors 

during, 132
drawings

cloning, 47
checking out with SharePoint, 318-319
color, applying, 77-78
combining on a single sheet, 263
exporting to image formats, 240-242
headers and footers, adding, 157-159
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FILL TOOL 375

pages
adding, 62
background pages, creating, 64
renaming, 66
reorganizing, 66
resizing manually, 71
resizing with Auto Size tool, 69
resizing with Size tool, 68
settings, customizing, 63
themes, applying, 76

saving with AutoSave, 51-52
scale of, changing, 71
shapes

frequently used, 84-86
Quick Shapes stencil, 83
selecting, 82

sharing
with email, 228-229
with SkyDrive, 230-232
with social networks, 232
with Visio Viewer, 230

shrinking to fit page, 259-260
themes

categories, 72
color, changing, 74
custom themes, creating, 75
variants, 73

tiled drawings, printing, 256-258
Drawing Scale tab, 71
drawing windows, 33, 53

closing, 53
opening second view of with New 

Window, 56
Presentation mode, 57
switching between, 55
task panes, 34
rulers and grids, 34

drop-down arrows, 23
duplicating

drawings, 47
pages, 63
shapes, 168

dynamic glue, 130-131
Dynamic Grid tool

arranging shapes with, 108-109
shapes, aligning, 109

E
eccentricity handles, 37
editing

Excel charts, 194
groups, 107
stencils, 93-96
text, 176-177

effects, Embellishment 
feature, 76

email, sharing drawings with, 228-229
Embellishment feature, 76, 148, 360
enabling

Presentation mode, 57
task panes, 54

Engineering templates, 44
Excel charts

editing, 194
inserting, 194-196

expanding tool groups on ribbon, 25
exporting drawings to image formats, 240-242
external data

linked data, refreshing, 295
linking with shape masters, 295-296
preparing to match shape data fields, 289
shapes, inking, 288-294

external images, importing, 190

F
Favorites stencil, 89
Field dialog box, 298
fields, adding to headers and footers, 211
file formats

image formats, exporting drawings to, 
240-242

older Visio formats, creating, 237
PDF, 210, 236
VSDX, 20, 50
XML, creating, 237
XPS, creating, 236

File tab, Backstage area, 31-33
Fill tool, 181
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376 FIXED LISTS, ADDING TO FORMAT FIELD

fixed lists, adding to Format field, 274
Flip Vertical tool, 114
floor plans

creating, 366-367
dimension lines, 368-369

flowcharts
BPMN, 346
creating, 10-11
cross-functional, 150

contextual ribbon, 344-345
swimlanes, 343

steps, connecting, 124-127
subprocesses, 340

Flowchart templates, 44
Fluent UI (Fluent User Interface), 22
footers, 211-213

adding to drawings, 157-159
fields, adding, 211

Format Painter tool, 175
Format Picture dialog, 190
Format Shape pane, 174, 190
Format Shape task pane, applying color to 

drawings, 78
formatting

connectors, 135
multiple objects, 175
shapes

common attributes, 173
less common attributes, 174-175

text, 176-178
formulas, performing calculations on shape 

data field, 298
frequently used Quick Shapes, modifying list 

of, 86
frequently used shapes, 84
full screen mode, enabling, 57

G
General templates, 44
generating reports, 283-285
glue, 129
Goldsmith, John, 313
graphics, importing vector-based, 196
grid, 34, 115-116

gridlines, printing, 221
groups, 102

creating, 103-106
editing, 107
resizing, 104
rotating, 104
when to avoid, 107
when to use, 102

guides, displaying, 115-116

H
handles

1D shape handles, 35
2D shape handles, 36
eccentricity handles, 37
vertex handles, 36

headers, 211-213
adding to drawings, 157-159
fields, adding, 211

help information, Visio Help, 305-306
hiding

comments, 324-326
grid, 115-116
ruler, 115-116

High Quality print output, 221-222
Highlighter tool (Ink), 327
Home tab

Change Shape tool, 87-89
color, applying to drawings, 77
Connection Point tool, 141
Distribute tools, 113-114
Orient Shapes tools, 114-115
Position tool, arranging diagrams, 111-112

Home Tab, straightening shapes with Auto 
Align tool, 110-111

Hopkins, Chris, 313
hyperlinks, 188

I
images

clip art, 193
external images, importing, 190
resizing, 192
resolution, adjusting, 192
searching for, 193
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MARSHALL, JOHN 377

SVG formatted images, 196
vector-based graphics, importing, 196

importing
CAD drawings, 197-199
external images, 190

improved touch support, 18
Info tab, 32

unnecessary data, removing from files, 
331-334

Ink tools, adding comments to Visio drawings, 
326-327

inserting
Excel charts, 194-196
pages in drawings, 62
SVG formatted images, 197

interface
Backstage area, 31-33
context menus, 31
drawing window, 33-34
Quick Access toolbar, 30
ribbon

commands, adding, 25-27
customizing, 24, 27
tool groups, expanding, 25

status bar, 33
tabs

contextual tabs, 23
controls available on, 22
template tabs, 24

internal resources, Viso Help, 305-306
Internet Explorer, Visio Viewer, 230

J-K
johnvisiomvp.wordpress.com, 312
jumping between drawing windows, 55

keyboards, touch keyboards, 251
keyboard shortcuts

displaying, 39-40
ToolTips
revealing, 38

L
Layer Properties dialog box, 220
layers, 103

creating, 163-165
selecting items to print with, 219-220
when to add, 165

Layout tool, 118-119
legends, inserting in diagrams, 299
less common format attributes, modifying, 

174-175
libraries, SharePoint, 316
line jumps (connectors), 

136-138
line properties of connectors, modifying, 

135-138
lines

curved lines, eccentricity handles, 37
vertex handles, 36

link data, refreshing, 295
linking shapes, 288

with Automatically Link, 293-294
with Data tab, 289-292
with dynamic glue, 130-131
with point-to-point glue, 129-130
with shape masters, 295-296

lists, 148
adding to Format field, 274

locating 
commands with Visio Options dialog box, 29
shapes with Search tool, 96-98

logical diagrams, 354-355

M
manual connections, creating with Connector 

tool, 127
manually resizing pages, 71
Maps and Floor Plans templates, 44
margins, 211-214
Marshall, John, 312
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378 MASTERS

masters, 90-91
creating, 94
creating based on grouped shapes, 106

maximizing print quality, 221-222
menus, context menus, 31
Microsoft Visio 2010 Business Process 

Diagramming and Validation (Parker), 311
Microsoft XPS Document Writer, 210
minimizing Shapes task pane, 54
mixed orientation drawings, printing, 260
modifying

common format attributes, 173
connectors with control handles, 138-139
containers, 147-150
less common format attributes, 174-175
line properties of connectors, 135-138
Quick Shapes, 84-86
text blocks, 179
title of background pages, 66

monotone printing, 223
More Shapes tab, 87
Mouse mode, switching to Touch mode, 

246-247
moving text blocks, 180-182
multiple objects, formatting, 175

N
network diagrams

logical diagrams, 354-355
rack diagrams, 355-357

Network templates, 44
new features in Visio 2013, 17

improved touch support, 18
streamlined layout, 18
VSDX file format, 20

New Window button, opening second view of 
drawing window, 56

nonorthogonal angles, 139

O
Office applications, compatibility with, 238-240
office.com, 307-310
the official Visio blog, 307

older Visio formats, creating, 237
open drawing windows

opening second view of, 56
viewing with Arrange All, 55

opening Print Settings pane, 214
options for stencils, 86-87
Org Chart tab, 24
organization charts, 359

creating, 363-365
creating manually, 361
photos, adding, 359-361

Organization Chart wizard, 363-365
organizing

diagrams with containers, 144-147
shapes

with containers, 103
with groups, 102
with layers, 103
with Layout tool, 118-119

orientation
mixed orientation drawings, printing, 260
of pages, changing, 67
of paper for printing, changing, 206-208
rotating shapes, 114-115

Orient Shapes tools, 114-115
overlapping shapes, troubleshooting with 

z-order, 118
overriding aspect ratio, 170

P
page breaks

Avoid Page Breaks tool, 260
displaying in Print Preview, 208

page scale, 259-260
pages

adding to drawings, 62
background pages

creating, 64
printing, 217-219
title, modifying, 66

containers
adding, 144-147
modifying, 147-150

duplicating, 63
orientation, changing, 67
printing, 216
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REDUCING FILE SIZE 379

renaming, 66
reorganizing, 66
settings, customizing, 63
size of, selecting, 68-69
themes, applying, 76

Page Setup dialog box, 63, 213
Page Size tab, 68
panes

Format Shape, 174
Print Preview, displaying page breaks, 208
Print Settings

background pages, removing, 217
opening, 214

Print Settings, 204-205
Shapes, 82
Size and Position, 170

paper orientation, changing for printing, 
206-208

Parker, David, 312
PDF format

creating, 236
printing to, 210

personalized templates, 45
personalizing stencils, 91-93
photos, adding to org charts, 359-361
Picture Tools Format tab, 190
plans, dimension lines, 368-369
point-to-point glue, 129-130
Pointer tool, handles

1D shape handles, 35
2D shape handles, 36

Pointer tool (Ink), 327
Position settings, changing for Data 

Graphics, 300
Position tool, arranging diagrams, 111-112
predefined scale, selecting for drawings, 71
preparing external data to match shape data 

fields, 289
Presentation mode, 33, 57
printers, displaying properties, 205
printing

background pages, 217-219
color settings, changing, 223

from Backstage, 204
background printing, 208
collation, 206
paper orientation, changing, 206-208
Print Settings pane, 204-205

gridlines, 221
headers and footers, configuring, 211-213
margins, configuring, 

213-214
Microsoft XPS Document Writer, 210
mixed orientation drawings, 260
page breaks, displaying, 208
page scale, 259-260
PDF file format, 210
print area, selecting, 214-216
Print Preview pane, 208
selecting specific pages to print, 216
shapes, 219
tile drawings, 256-258
using layers, 219-220

print jobs, testing, 210
Print Preview pane, 208
print quality, maximizing, 221-222
Print Settings pane, 204-205

background pages, removing, 217
monotone printing, 223
opening, 214

properties
of connectors, 129, 135-138
of printer, displaying, 205
of SmartShapes, viewing, 187

Q
Quick Access toolbar, 22, 30
Quick Shapes stencil, 83

frequently used shapes, modifying, 86
modifying, 84

R
rack diagrams, 355-357
Re-Layout Page drop-down, 118
Recent Drawings list, copying drawings, 47
reducing file size, 332-334
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380 REFRESHING DATA LINKED FROM EXTERNAL SOURCE

refreshing data linked from external source, 295
removing

background pages from Print Settings 
pane, 217

line jumps, 138
unnecessary data from files, 331-334

renaming pages, 66
Reorder Pages dialog box, 67
reorganizing pages, 66
Report Definition Wizard, 279-285
reports

creating, 279-285
subtotals, adding, 285
totals, adding, 285

resize handles, 170
resizing

Auto Resize feature, 338
grouped shapes, 104
images, 192
pages

with Auto Size tool, 69
with Size tool, 68

shapes, 170-171
swimlanes, 343
text, 179

resolution of images, adjusting, 192
resources, office.com website, 307-310
revealing ToolTips, 38
Review tab, adding Track Markup tool, 329-331
ribbon

commands, adding, 25-27
customizing, 24-27
tabs

contextual tabs, 23
controls available on, 22
template tabs, 24

tool groups, expanding, 25
right-click menus, 31

rotate handles, 171
rotating

grouped shapes, 104
shapes, 114-115, 171-172

Roth, Chris, 312
routing styles (connectors), 136

ruler
displaying, 115-116
drawing window, 34

Ruler and Grid dialog box, 116

S
Save As

saving diagrams, 49
.vsdx format, 50

saving
diagrams

with AutoSave, 51-52
with Save As, 49

shape data fields, 276-278
VSDX format, 50

scale of drawings, changing, 71
Schedule templates, 45
ScreenTips, 155
searching for images, 193
Search tool, locating shapes with, 96-98
selecting

items to print with layers, 219-220
print area, 214-216
shapes, 82
size of pages with Size tool, 68-69
specific pages to print, 216
specific shapes to print, 219
templates, 45

shape data
fields

adding, 270-274
saving, 276-278
text, displaying, 278

lists, adding, 274
types of, 268
viewing, 186

shapes
1D, handles, 35
2D

handles, 36
resizing, 170

aligning on Dynamic Grid, 109
arranging with Dynamic Grid tool, 108-109
attributes, formatting, 173-175
blending, 348
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SPLITTING CONNECTORS, BEHAVIOR OF CONNECTORS DURING 381

callouts, adding, 151-154
changing with Change Shape tool, 87-89
comments

adding, 323-324
hiding, 324-326

connection points, adding, 140-142
connectors, 124-125

behavior during drag operations, 132
behavior when deleting shapes, 133-134
behavior when splitting connectors, 

132-133
control handles, 138-139
creating with AutoConnector, 125-127
creating with Connector tool, 127
dynamic glue, 130-131
formatting, 135
line jumps, 136-138
point-to-point glue, 129-130
properties, 129
routing styles, 136

containers, 103
data fields, 266-274
Decision shapes, 339
distributing, 113-114
duplicating, 168
frequently used, 84-86
groups

adding to stencils, 106
creating, 103-106
editing, 107
resizing, 104
when to avoid, 107
when to use, 102

ink shapes, closing, 328
layers, 103
linking to external data, 288

refreshing linked 
data, 295

with Automatically Link, 293-294
with Data tab, 289-292

locating with Search tool, 96-98
masters, creating, 94
multiple shapes, formatting, 175
organizing with Layout tool, 118-119
overlapping, changing z-order of, 118
printing, 219
Quick Shapes stencil, 83

frequently used shapes, 86
modifying, 84

resizing, 170-171
rotating, 114-115, 171-172

selecting, 82
stencils

available stencils, browsing, 87
customizing, 91-93
editing, 93-96
Favorites stencil, 89
masters, 90-91
options, 86-87

straightening with Auto Align tool, 110-111
text blocks

background, changing, 181-183
modifying, 179
moving, 180-182

themes, changing, 76
ungrouping, 102

Shapes pane, 82
Shapes task pane, 54

minimizing, 54
undocking, 54

SharePoint, 316
co-authoring, 320-322
libraries, 316
versioning, 320
Visio drawings, checking out, 318-319

SharePoint 2013 Workflows, 347
sharing drawings. See also collaboration

with email, 228-229
with SkyDrive, 230-232
with social networks, 232
with Visio Viewer, 230

Size and Position pane, 170-172
Size tool, selecting size of pages, 68-69
SkyDrive, 50, 230-232
SmartShapes, 185

control handles, 187
hyperlinks, 188
properties, viewing, 187
shape data, 186
smart tags, 188

smart tags, 188
social networks, sharing drawings with, 232
Software and Database templates, 45
Space shapes, 367-368
spacing, 109
splitting connectors, behavior of connectors 

during, 132-133
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382 STATUS BAR

status bar, 33
stencils

browsing available stencils, 87
Callout Stencil, 154
customizing, 91-93
editing, 93-96
Favorites stencil, 89
groups, adding, 106
masters, 90-91

creating, 94
creating based on groups, 106

options for, 86-87
Quick Shapes, 83

frequently used, modifying list of, 86
modifying, 84

Timeline, 357-359
steps, connecting in flowcharts, 124-127
straightening shapes with Auto Align tool, 

110-111
streamlined layout, 18
Stroke Eraser tool (Ink), 327
subprocesses, 340
subtotals, adding to reports, 285
SVG formatted images, 196
swapping shapes with Change Shape tool, 89
swimlanes, 150, 343
switching 

between drawing windows, 55
between Touch mode and Mouse mode, 

246-247
between windows, 53

T
tabs, 53

controls available on, 22
Data tab, linking external data to shapes, 

289-292
Drawing Scale tab, 71
File tab, Backstage area, 31-33
Home tab

Auto Align tool, 110-111
Change Shape tool, 87-89
color, applying to drawings, 77
Connection Point tool, 141

Distribute tools, 113-114
Orient Shapes tools, 114-115
Position tool, 111-112

Info tab, 32
More Shapes, 87
Page Size tab, 68
Print Setup, 68
Print Setup tab, 68

task panes, 53
anchoring, 55
enabling/disabling, 54
Format Shape, applying color to 

drawings, 78
rulers and grids, 34
Shapes task pane, 54

Template Gallery, 42-45
template tabs, 24
templates, 13-15, 42

Block Diagram with Perspective, 349-350
Business templates, 44
categories of, 42-45
creating, 252, 255
diagrams, creating without, 46
Engineering templates, 44
Flowchart templates, 44
General templates, 44
Maps and Floor Plans templates, 44
Network templates, 44
personalized templates, 45
Schedule templates, 45
selecting, 45
Software and Database templates, 45
stencils, browsing available stencils, 87
Template Gallery, 42
Timeline, 357-359

testing print jobs, 210
text

aligning, 179
displaying in shape data fields, 278
editing, 176-177
formatting, 177-178
resizing, 179

text blocks
background, changing, 181-183
modifying, 179
moving, 180-182
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WEBSITES 383

Text Block tool, 180
text boxes, 160
Text Edit mode, 177
text fields, 160-162
Text tool, 177
themes

categories, 72
color, changing, 74
custom themes, creating, 75
for shapes, changing, 76
variants, 73

tiled drawings, printing, 256-258
timelines, 357-359
title of background pages, modifying, 66
tool groups, expanding on ribbon, 25
tools

Flip Vertical, 114
Pointer tool, 35

ToolTips, revealing, 38
totals, adding to reports, 285
touch controls, 248-251
touch keyboard, 251
touchscreens

shapes, working with, 248
touch controls, 248-251
Touch mode
switching to Mouse mode, 246-247

Track Markup tool, 329
adding to Review tab, 329-331

troubleshooting overlapping shapes with 
z-order, 118

types of shape data, 268

U
uncollated printing, 206
undocking Shapes task pane, 54
ungrouping shapes, 102
unnecessary data, removing from files, 331-334
uses for shape data, 268
Using Visio 2010 (Roth, Que Publishing), 311

V
validating diagrams, 346
variants of themes, 73
vector-based graphics, importing, 196
versioning (SharePoint), 320
vertex handles, 36
viewing

open drawing windows with Arrange All, 55
shape data, 186
SmartShape properties, 187

View tab
Dynamic Grid tool, arranging shapes with, 

108-109
task panes, enabling/disabling, 54

visguy.com, 311
Visio 2010 Step by Step (Helmers, Microsoft 

Press), 311
VisioCafe, 313
Visio Help, 305-306
visio.mvps.org, 313
Visio Options dialog box

commands, locating, 29
ribbon, customizing, 25

Visio Professional 2013, 16
Visio Pro for Office 365, 16
Visio Standard 2013, 16
Visio Viewer, 230, 304
visualsignals.typepad.co.uk, 313
VSDX file format, 20, 50

W
web pages, creating from diagrams, 234
websites

bvisual.net, 312
johnvisionmvp.wordpress.com, 312
office.com, 307-310
visguy.com, 311
visiocafe.com, 313
visio.mvps.or, 313
visualsignals.typepad.co.uk, 313
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384 WINDOWS

windows
drawing windows, 53

closing, 53
opening second view of with New, 56
Presentation mode, 57
switching between, 55

tabs, 53
workflows, SharePoint 2013 Workflows, 347

X-Y-Z
XML file format, creating, 237
XPS file format, creating, 236

zooming in and out with Print Preview, 208
z-order of shapes, changing, 118
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